I. Creating a Worksheet and an Embedded Chart  
   a. Objectives  
      i. Start and Quit Excel  
      ii. Describe the Excel worksheet  
      iii. Enter text and numbers  
      iv. Use the Sum button to sum a range of cells  
      v. Copy the contents of a cell  
      vi. Save a worksheet  
      vii. Format cells in a worksheet  
      viii. Create a chart  
      ix. Change document properties  
      x. Print a worksheet  
      xi. Open a worksheet  
      xii. Use the AutoCalculate area to determine statistics  
      xiii. Correct Errors on a worksheet  
      xiv. Use Excel Help to answer questions  

II. What is Microsoft Office Excel 2007?  
   Microsoft Office Excel 2007 is a powerful spreadsheet program that allows users to organize data, 
   complete calculations, make decisions, graph data, develop professional looking reports, publish 
   organized data to the Web, and access real-time data from Web sites. The four major parts of Excel are:  
   1. Workbooks and Worksheets  
      a. Workbooks are a collection of worksheets. Worksheets allow users to enter, calculate, 
         manipulate, and analyze data such as numbers and text. The terms worksheet and 
         spreadsheet are interchangeable.  
   2. Charts  
      a. Excel can draw a variety of charts.  
   3. Tables  
      a. Tables organize and store data within worksheets. For example, once a user enters data 
         into a worksheet, an Excel table can sort the data, search for specific data, and select data 
         that satisfies defined criteria.  
   4. Web Support  
      a. Web support allows users to save Excel worksheets or parts of a worksheet in HTML 
         format, so a user can view and manipulate the worksheet using a browser. Excel Web 
         support also provides access to real-time data such as stock quotes, using Web queries.  

This latest version of Excel makes it much easier than in previous versions to perform common 
functions, by introducing a new style of user interface. It also offers the capability of creating larger 
worksheets, improving formatting and printing, improved charting and table functionality, industry-
standard XML support that simplifies the sharing of data within and outside an organization, improved 
business intelligence functionality, and the capability of performing complex tasks on a server. 

The first step in creating an effective worksheet is to make sure you understand what is required. The 
person or persons requiring the worksheet should supply their requirements in a requirements 
document. A requirements document includes a need statement, source of data, summary of 
calculations, and any other special requirements for the worksheet, such as charting and Web support. 

III. Starting Excel  
   The following diagram displays the steps, based upon a typical installation of Microsoft Office, in which 
to start Excel.
1. Click the Start button on the Windows taskbar to display the Start menu.
2. Point to All Programs on the Start menu to display the All Programs submenu.
3. Point to Microsoft Office on the All Programs submenu to display the Microsoft Office submenu.
4. Click Microsoft Office Excel 2007 command

IV. The Excel Workbook
The Excel window consists of a variety of components to make your work more efficient and worksheets more professional. These include the document window, Ribbon, Mini toolbar and shortcut menus, Quick Access Toolbar and Office Button. Some of these components are common to other Microsoft Office 2007 programs, others are unique to Excel.

When Excel starts, it creates a new blank workbook, called Book 1. The workbook is like a notebook. Inside the workbook are sheets, each of which is called a worksheet. Excel opens a new workbook with three worksheets.

If necessary, you can add additional worksheets as long as your computer has enough memory to accommodate them. Each worksheet has a sheet name that appears on a sheet tab at the bottom of the workbook.

a. The Worksheet
The worksheet is organized into a rectangular grid containing vertical columns and horizontal rows. A column letter above the grid, also called, the column heading, identifies each column. A row number on the left side of the grid, also called the row heading, identifies each row.
The intersection of each column and row is a cell. A **cell** is the basic unit of a worksheet into which you enter data. Each worksheet in a workbook has 16,384 columns and 1,048,576 rows for a total of 17,179,869,180 cells. Only a small fraction of the active worksheet appears on the screen at one time.

A cell is referred to by its unique address, or **cell reference**, which is the coordinates of the intersection of a column and a row. To identify a cell, specify the column letter first, followed by the row number. For example, cell reference D11 refers to the cell location at the intersection of column D and row 11.

One cell on the worksheet, designated the **active cell**, is the one into which you can enter data. The active cell is identified in three ways. First, a heavy border surrounds the cell; second, the active cell reference shows immediately above column A in the Name box; and third, the column heading A and row heading 1 are highlighted so it is easy to see which cell is active.

The horizontal and vertical lines on the worksheet itself are called **gridlines**. Gridlines make it easier to see and identify each cell in the worksheet. If desired, you can turn the gridlines off so they do not show on the worksheet, but it is recommended that you leave them on for now.
The mouse pointer appears as a block plus sign whenever it is located in a cell on the worksheet. Another common shape of the mouse pointer is the block arrow. The mouse pointer turns into the block arrow whenever you move it outside of the worksheet or when you drag cell contents between rows or columns. There are many other mouse pointer shapes depending on where the mouse pointer is placed in the worksheet window.

V. Worksheet Window
   You view the portion of the worksheet displayed on the screen through a worksheet window. The default view is normal view. Below and to the right of the worksheet window are scroll bars, scroll arrows, and scroll boxes that you can use to move the worksheet window around to view different parts of the active worksheet. To the right of the sheet tabs at the bottom of the screen is the tab split box. You can drag the tab split box to increase or decrease the view of the sheet tabs. When you decrease the view of the sheet tabs, you increase the length of the horizontal scroll bar, and vice versa.

   a. Status Bar
      The status bar is located immediately above the Windows taskbar at the bottom of the screen. The status bar presents information about the worksheet, the function of the button the mouse pointer is pointing to, or the mode of Excel. Mode indicators, such as Enter and Ready, appear on the status bar and specify the current mode of Excel. When the mode is Ready, Excel is ready to accept the next command or data entry. When the mode indicator reads Enter, Excel is in the process of accepting data through the keyboard into the active cell.

      Keyboard indicators, such as Scroll Lock, show which toggle keys are engaged. Keyboard indicators appear to the right of the mode indicator. Toward the right edge of the status bar are buttons and controls you can use to change the view of a document and adjust the size of the displayed document.

   b. Ribbon
      The Ribbon located near the top of the Excel window, is the control center in Excel. The Ribbon provides easy, central access to the tasks you perform while creating a worksheet. The Ribbon consists of tabs, groups and commands. Each tab surrounds a collection of groups, and each group contains related commands.

      When you start Excel, the Ribbon displays seven top-level tabs, Home, Insert, Page Layout, Formulas, Data, Review, and View. The Home tab, called the primary tab, contains groups with the more frequently used commands. To display a different tab on the Ribbon, click the top-level tab. That is, to display the Insert tab, click Insert on the Ribbon. To return to the Home tab, click Home on the Ribbon. The tab currently displayed is called the active tab.

      To display more of the document in a document window, some users prefer to minimize the Ribbon, which hides the groups on the Ribbon and displays only the top-level tabs. To use commands on a minimized Ribbon, click the top-level tab.

      Each time you start Excel, the Ribbon appears the same way it did the last time you used Excel. In addition to top-level tabs, Excel displays other tabs, called contextual tabs, when you perform certain tasks or work with objects such as charts or tables. If you insert a chart in the worksheet, for example, the Chart Tools tab and its related subordinate Design tab appear. When you are finished working with the chart, the Chart Tools and Design tabs disappear from the Ribbon. Excel determines when contextual tabs should appear and disappear, based on the tasks you perform.

      Ribbon Commands include buttons, boxes (text boxes, check boxes, etc.), and galleries. A gallery is a set of choices, often graphical, arranged in a grid or in a list. You can scroll through choices on an in-Ribbon gallery by clicking the gallery’s scroll arrows. An in-Ribbon gallery shows common gallery choices on the Ribbon rather than in a dropdown list. Most galleries support live preview, which is a feature that allows you to point to a gallery choice and see its effect in the worksheet without actually selecting the choice.
c. Formula Bar
The formula bar appears below the Ribbon. As you type, Excel displays the entry in the **formula bar**. You can make the formula bar larger by dragging the sizing handle on the formula bar or clicking the expand button to the right of the formula bar. Excel also displays the active cell reference in the **Name box** on the left side of the formula bar.

![Image of Excel interface with labels for Ribbon, Home tab, Formula bar, and Name box](image)

---

d. The Mini toolbar, which appears automatically based on tasks you perform (such as selecting text), contains commands related to changing the appearance of text in the worksheet. All commands on the Mini toolbar also exist on the Ribbon. The purpose of the Mini toolbar is to minimize mouse movement. For example, if you want to format text using a command that is currently not displayed on the active tab, you can use the command on the Mini toolbar – instead of switching to a different tab to use the command.

When the Mini toolbar appears, it initially is transparent. If you do not use the transparent Mini toolbar, it disappears from the screen. To use the Mini toolbar, move the mouse pointer into the toolbar, which causes the Mini toolbar to change from a transparent to bright appearance.

![Image of Transparent and Bright Mini toolbar](image)
VI. Selecting a Cell
To enter data into a cell, you first must select it. The easiest way to select a cell (make it active) is to use the mouse to move the block plus sign mouse pointer to the cell and then click.

An alternative method is to use the arrow keys that are located just to the right of the typewriter keys on the keyboard. An arrow key selects the cell adjacent to the active cell in the direction of the arrow on the key.

VII. Entering Text
In Excel, any set of characters containing a letter, hyphen (as in a telephone number), or space is considered text. Text is used to place titles, such as worksheet titles, column titles, and row titles, on the worksheet.

a. Entering Text in a Cell
When you complete a text entry into a cell, a series of events occurs. First, Excel positions the text left-aligned in the cell. Left-aligned means the cell entry is positioned at the far left in the cell.

Second, when the text is longer than the width of a column, Excel displays the overflow characters in adjacent cells to the right as long, as these adjacent cells contains no data.

Third, when you complete an entry by clicking the Enter box, the cell in which the text is entered remains the active cell.

b. Correcting a Mistake while Typing
If you type the wrong letter and notice the error before clicking the Enter box or pressing the ENTER key, use the BACKSPACE key to delete all the characters back to and including the incorrect letter. To cancel the entire entry before entering into the cell, click the Cancel box in the formula bar or press the ESC key. If you see an error in a cell after entering the text, select the cell and retype the entry.

VIII. Entering Numbers
In Excel, you can enter numbers into cells to represent amounts. A number can contain only the following characters:

\[0 1 2 3 4 5 6 7 8 9 + - ( ) , / \$ \% E e\]

If a cell entry contains any other keyboard character (including spaces), Excel interprets the entry as text and treats it accordingly.

- Discuss and demonstrate entering text
- Discuss and demonstrate text overflow
- Discuss and demonstrate calculating sum
- Discuss and demonstrate copying cells

IX. Saving a Project
While you are building a worksheet in a workbook, the computer stores it in memory. When you save a workbook the computer places it on a storage medium such as a USB flash drive, CD, or hard disk. A saved workbook is referred to as a file. A file name is the name assigned to a file when it is saved. It is important to save the workbook frequently for the following reasons:

- The worksheet in memory will be lost if the computer is turned off or you lose electrical power while Excel is open.
- If you run out of time before completing your workbook, you may finish your worksheet at a future time without starting over.
X. Formatting the Worksheet

You format a worksheet to emphasize certain entries and make the worksheet easier to read and understand.

Before Formatting

<table>
<thead>
<tr>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk and Rock Music</td>
<td>First Quarter Rock-It MP3 Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

After Formatting

<table>
<thead>
<tr>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk and Rock Music</td>
<td>First Quarter Rock-It MP3 Sales</td>
</tr>
</tbody>
</table>

- Discuss and demonstrate font size, color and style
- Discuss and demonstrate numbering formatting
- Discuss and demonstrate formatting titles and subtitles and column headings
- Discuss and demonstrate merging cells
- Discuss and demonstrate position data in cells
- Discuss and demonstrate changing column width and row height

The commands to insert a chart are located on the Insert tab. With the range to chart selected, you click the Column button on the Ribbon to initiate drawing the chart. The area on the worksheet where the chart appears is called the chart location.

XI. Changing Document Properties and Saving Again

Excel helps you organize and identify your files by using document properties, which are the details about a file. Document properties, also known as metadata, can include such information as the project author, title, or subject. Keywords are words or phrases that further describe the document. For example, a class name or worksheet topic can describe the file’s purpose or content.

Document properties are valuable for a variety of reasons:
- Users can save time locating a particular file because they can view a document’s properties without opening the document.
- By creating consistent properties for files having similar content, users can better organize their workbooks.
- Some organizations require Excel users to add document properties so that other employees can view details about these files.

(NOTE: In this class all created workbooks must have student name for author, course and section for subject and Assignment #? for keyword.)
Five different types of document properties exist, but the more common ones used in this book are standard and automatically updated properties. Standard properties are associated with all Microsoft Office documents and include author, title, and subject. Automatically updated properties include file system properties, such as the date you create or change a file, and statistics, such as the file size.

The Document Information Panel contains areas where you can view and enter document properties. You can view and change information in this panel at any time while you are creating a document. Before saving your workbook again, you may want to add your name and course information as document properties.

XII. Printing a Worksheet
After you create a worksheet, you often want to print it. A printed version of the worksheet is called a hard copy or printout. Printed copies of your worksheet can be useful for the following reasons:

- Many people prefer proofreading a hard copy of the worksheet rather than viewing the worksheet on the screen to check for errors and readability.
Someone without computer access can view the worksheet’s content.
Copies can be distributed as handouts to people during a meeting or presentation.
Hard copies can serve as reference material if your storage medium is lost or becomes corrupted and you need to recreate the worksheet.

It is good practice to save a workbook before printing it, in the event you experience difficulties with the printer.

XIII. Starting Excel and Opening a Workbook
Once you have created and saved a workbook, you may need to retrieve it from your storage medium. For example, you might want to revise a worksheet or reprint it. Opening a workbook requires that Excel is running on your computer. Here are the steps taken to open an Excel workbook.

- Click the Start button on the Windows taskbar to display the Start menu.
- Point to All Programs on the Start menu to display the All Programs submenu and then point to Microsoft Office in the All Programs submenu to display the Microsoft Office submenu.
- Click Microsoft Office Excel 2007 on the Microsoft Office submenu to start Excel and display a new blank worksheet in the Excel window.
- Click the Office Button to display the Office Button menu.
- Click Open on the Office Button menu to display the Open dialog box.
- Select the file name to open and click the Open button.

XIV. Excel Help
At any time while using Excel, you can find answers to questions and display information about various topics through Excel.